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Foreword 

This report has been prepared by the British Geological Survey (BGS), as a set of instructions 
to provide assistance with the extraction of useful geospatial data from the wealth of publicly 
available scanned legacy seismic data that can be accessed via the BGS Offshore Geoindex.  
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Summary 

This report provides a detailed workflow to extract spatially referenced lithostratigraphic 
information from scanned seismic and borehole records curated by the British Geological 
Survey. 

The rationale for this report is to enable any technical staff proficient in, and with access to, 
ArcGIS Pro, and some form of drawing software e.g., CorelDraw, to make digital picks of 
geological information from the wealth of legacy data and therefore maximise outputs. 

The instructions contained within the report are written in such a way that they can be used by, 
for example, undergraduate university students enrolled in geoscience programs. Therefore, 
this report could be used to underpin undergraduate and postgraduate research projects looking 
to utilise open-source data, which would be mutually beneficial for the strategic goals of BGS to 
improve existing maps of the shallow geology on the UK continental shelf (UKCS). 

The workflow assumes that the user starts with no data but has access to the required software. 
Detailed instructions are provided to direct the user to the relevant data sources and how to 
download and import the data into their working areas. 

Users following the workflow, would progress from data access, through download and data 
preparation, geospatial referencing of scanned (originally paper-based-datasets), to ultimately 
producing digital X,Y,Z data points for interpreted geological horizons. The ouput X,Y,Z data 
points can used to generated gridded surfaces or be imported into a GIS program or subsurface 
data visualisation program, where they can be used to aid, or complement, interpretations 
picked on modern digital SEGY-format seismic data. 

The data available on the offshore geoindex are delivered under the terms of the Open 
Government Licence, subject to the following acknowledgement accompanying the reproduced 
BGS materials: “Contains British Geological Survey materials © UKRI [year]”. Contact us 
(digitaldata@bgs.ac.uk) if you create something new and innovative that could benefit others. 
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Introduction 

The National Geological Data Centre hosted at the British Geological Survey (BGS) curates a 
wealth of scanned seismic data that was acquired during the mid-late 20th century. These data 
are publicly available and can be accessed through the BGS Offshore Geoindex.  

The Offshore Geoindex also hosts shapefiles for the geographical positions of the scanned 
seismic data and the coordinates of shot points used during the acquisition. Using these 
shapefiles in combination with the image files, the images can be spatially referenced in GIS 
software. The spatial reference assigned to the scanned images can be quality checked against 
open-source bathymetry data from the Admiralty Marine Data Portal, where the scans and 
existing bathymetry are coincident. The combination of these elements provides a method 
through which geological information in the subsurface can be digitised, the details of which is 
outlined in the workflow section of this report. 
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Workflow 

This report will demonstrate the workflow steps using example data from the Moray Firth, in 
north-eastern Scotland. 

1 CREATE A PROJECT SPACE 

Most of the workflow requires a GIS software package, and the outlined steps in this report use 
ArcGIS Pro. Before getting started, you should create a project space where the datasets 
should be downloaded/collated, and the GIS project set up. 

1.1 You may want to create the project space on a local drive to your PC, so that the large 
datasets will load quickly (back up the project later to a network drive). 
 
Inside your project space, create a folder for the GIS project e.g., 
‘Scanned_Seismic_GIS’, a ‘Datasets’ folder, within which create a folder for 
‘Scanned_Seismic’ and ‘Bathymetry’. For example, the directory structure would look like: 
 
C:\local\Scanned_Seismic_Project 
 
  |--Datasets 
 
  | |--Scanned_Seismic 
 
  | |--Bathymetry 
 
  |--Scanned_Seismic_GIS 

 

 

Figure 1.1 
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2 DOWLOAD DATA AND SET UP ARCGIS PRO PROJECT 

To ensure the best possible accuracy to the results of the process detailed in this report, you 
should endeavour to use scanned seismic data that is coincident with high-resolution 
bathymetry data. 

The two platforms from which to retrieve necessary datasets are: 
 

• The BGS Offshore Geoindex (https://www.bgs.ac.uk/map-viewers/geoindex-offshore/) 
 

• The Admiralty Marine Data Portal 
(https://datahub.admiralty.co.uk/portal/apps/sites/#/marine-data-portal) 
 

 

2.1 Go to the offshore Geoindex and scroll down to and click on the ‘Open BGS Geoindex 
(offshore) button. 

 

Figure 2.1.  

2.2 You are confronted with a page that looks like this: 
 

 

Figure 2.2. Basemap sources: Esri, GEBCO, Garmin, NaturalVue | Esri, GEBCO, Garmin, NGS 

  

https://www.bgs.ac.uk/map-viewers/geoindex-offshore/
https://datahub.admiralty.co.uk/portal/apps/sites/#/marine-data-portal
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2.3 Click on the arrow next to ‘Map Layers’ to expand the map Geoindex contents list. 
 

 

Figure 2.3 

2.4 Click on the + next to Survey Information to expand the layers. Then select the tick boxes 
next to ‘Shot Points’ and ‘Seismic Reflection’. 
 

 

Figure 2.4 
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2.5 Zoom in on the map by using the mouse scroll or controls at the top right until you see 
these datasets appear. 

 

 

Figure 2.5. Basemap sources: Esri, GEBCO, Garmin, NaturalVue | Esri, GEBCO, Garmin, NGS 

 

2.6 Centre your map on your particular region of interest, then click on ‘Clip & Download’ at the 
base of the ‘Map Layers’ panel. 

 
 

 

Figure 2.6 
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2.7 A dialogue box will have appeared, click on ‘Draw AOI’. You should also be able to move 
the dialogue box out of the way by clicking on the dark-blue top ribbon and dragging it. 
 

 

Figure 2.7 

2.8 Draw a rectangle over the area of interest by holding down the left-hand mouse button and 
dragging. You may want to select a larger area than depicted in the image below, to 
ensure you get sufficient coverage that includes the start and ends of seismic lines you 
want to work on. 

 

 

Figure 2.8. Basemap sources: Esri, GEBCO, Garmin, NaturalVue | Esri, GEBCO, Garmin, NGS   
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2.9 Once happy with the selection, click on ‘Go’ at the bottom of the dialogue box. 

 

Figure 2.9. Basemap sources: Esri, GEBCO, Garmin, NaturalVue | Esri, GEBCO, Garmin, NGS 

2.10 The platform will take a few moments to clip and download the data, once complete you 
will get the following message: 

 

Figure 2.10 

2.11 Click on ‘Get Data’,and save the data to your 
C:\local\Scanned_Seismic_Project\Datasets\Scanned_Seismic folder. The data will have 
downloaded in a zipped folder. 
 

 

Figure 2.11  
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2.12 Extract the contents to the ‘Scanned_Seismic’ folder (delete ‘geoindex’ in the path before 
pressing ‘Extract’ to avoid generating duplicate folders). 

 

 

Figure 2.12 

2.13 The relevant files are stored within a subfolder called ‘zipfolder’. Open the folder and move 
the files within one directory up so that they appear in the ‘Scanned_Seismic’ folder. You 
should see files for ‘Seismic_Reflection’ and ‘Shot_Points’. Delete the ‘zipfolder’ and 
‘geoindex.zip’ folders. 
 

 

Figure 2.13  
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2.14 Before downloading the bathymetry data, the next step is to create a GIS project. Open 
ArcGIS Pro, choose ‘Map’ under ‘New Project’ and when the ‘New Project’ dialogue box 
appears, deselect the checkbox next to ‘Create a folder for this project’, then click on the 
folder icon next to location to select your 
C:\local\Scanned_Seismic_Project\Scanned_Seismic_GIS folder. Give the Project a 
suitable name e.g., ‘Scanned_Seismic_Maps’, click ok. 
 

 

Figure 2.14 

 
2.15 Change the name of the default map to ‘Reference_Map’. 

 

 

Figure 2.15 
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2.16 Right-click on the map in the table of contents and select ‘Properties’. 
 

 

Figure 2.16 

 
2.17 Select the ‘Coordinate Systems’ tab, then find and select ‘British National Grid’ from 

‘Projected Coordinate Systems > National Grids > United Kingdom’ (also add this CRS to 
your favourites), and click OK. 
 

 

Figure 2.17 
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2.18 Open the Catalog pane, and right click on ‘Folders’ and select ‘Add Folder Connection’, 
choose your ‘Datasets’ folder and click OK. Your Datasets folder should now appear in the 
Catalog (you may need to right-click > Refresh). 

 

 

Figure 2.18 

 

2.19 Expand ‘Scanned_Seismic’ to see the shapefiles that were downloaded. 
 
 

 

Figure 2.19 
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2.20 Select the Seismic_Reflection and Shot_Points .shp files and drag and drop them into the 
map. In the Drawing Order, move Shot_Points above Seismic_Reflection. 
 

 

Figure 2.20 

 
 

2.21 The next step is to download coincident UK Hydrographic Office Civil Hydrography 
Programme bathymetry data from the Admiralty Marine Data Portal 
(https://datahub.admiralty.co.uk/portal/apps/sites/#/marine-data-portal).  
 
Scroll down on the webpage to click on ‘Discover’ under ‘Seabed Mapping Services’. 
 

 

Figure 2.21. © Crown Copyright 2020 UK Hydrographic Office 

  

https://datahub.admiralty.co.uk/portal/apps/sites/#/marine-data-portal
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2.22 Scroll down on the next page and click on ‘Try the new service’ under ‘Beta Seabed 

Mapping Data Service’ 
 

 

Figure 2.22. © Crown Copyright 2020 UK Hydrographic Office 

 

2.23 Once the Seabed Mapping Service has opened, zoom in on your area of interest. Select 
either the ‘Select features by drawing a custom polygon’ or ‘Select features by drawing a 
rectangle’. Draw around your area of interest by clicking once and dragging (if an error 
message saying your selected area exceeds 1000 km2, just reduce the size of the 
polygon/rectangle – the relevant datasets should still be selected). The datasets within 
your selection will appear in a panel on the right, tick the checkboxes next to the relevant 
datasets to your work. Click Next. 
 

 

Figure 2.23. © Crown Copyright 2020 UK Hydrographic Office. Basemap sources: © MapTiler © 
OpenStreetMap contributors 
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2.24 Agree to the Terms of Use and click Download, you will need to enter your email and login 
or create a free account. 
 

 

Figure 2.24. © Crown Copyright 2020 UK Hydrographic Office 

 
2.25 The data will be downloaded in a zipped folder. Extract the contents into your 

C:\local\Scanned_Seismic_Project\Datasets\Bathymetry folder. 
 

 

Figure 2.25 
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2.26 Inside the folders that have been extracted, you will see a series of files, and another 
zipped folder. The useful files here are the BAG file(s). 
 

 

Figure 2.26 

2.27 In your GIS project, in the Catalog pane, you should see the downloaded folders and files 
within the tree. The BAG files will appear as rasters. Expand one of the rasters to see the 
different bands – generally they will have an ‘elevation’ band and an ‘uncertainty’ band. 
Drag and drop an elevation band into your map. When asked to Build pyramids, leave the 
defaults (checkbox next to ‘Build’ under Pyramids is selected) and click OK. 

 

 

Figure 2.27 

2.28 Add as many of the elevation rasters as you require to your map in the same way. The 
vertical datum for the UKHO bathymetry is metres below lowest astronomical tide (mLAT). 

 
2.29 You may want to create a seamless bathymetry dataset over your area of interest by 

combining multiple rasters. To do this, go to the Analysis tab, open Tools, and in the 
Geoprocessing pane that appears, use the search bar to search for ‘Mosaic to new raster’. 
 

 

Figure 2.28  
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2.30 Select the rasters you have in your map (the elevation bands) as the input rasters, select 
your C:\local\Scanned_Seismic_Project\Datasets\Bathymetry folder as the Output 
Location, give a name that is less than 13 characters long, choose the relevant UTM zone 
as the Spatial Reference (the same coordinate reference system as the original 
bathymetry downloads), change the Pixel type to ’16 bit unsigned’, input a suitable cellsize 
that is similar to the original downloaded bathymetry, input 1 as the number of bands, set 
the Mosaic Operator and Mosaic Colormap Mode to ‘First’. Everything else can be left as 
the defaults. Run. 
 

 

Figure 2.29 

2.31 The new raster should have appeared in the table of contents if the process completed 
correctly. If so, remove the originally downloaded bathymetry rasters from your map by 
right-clicking on them in the table of contents and selecting ‘remove’, so you are left with 
the mosaic. Change the name of the layer for the merged bathymetry in the table of 
contents to add the suffix ‘mLAT’. 
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2.32 The next step is to generate a bathymetry dataset that is plotted in two-way-travel time 

from the merged bathymetry raster, so it can be compared directly with the scanned 
seismic data. To do this, you need to perform a depth to time conversion. In Analysis > 
Tools search for ‘Raster Calculator’.  
 

 

Figure 2.30 

2.33 Use the Raster Calculator tool to create an expression that will convert the bathymetry 
values to two-way-travel time ((2 × Raster) ÷ water velocity in metres per second). Use an 
appropriate value for the velocity. In this example 1490 m/s is used. Give the output raster 
an appropriate name i.e., the same as the name you gave the merged depth bathymetry, 
but with the suffix ‘TWT’, this time use the default output location (which will be the 
project’s geodatabase, but check the raster can be exported later) – you may also want to 
add the velocity value you used to the name if you have enough character space (at the 
very least, make a note of the velocity you used). Go to the ‘Environments’ tab and select 
the same UTM zone coordinate system you have been using for the bathymetry as the 
Output Coordinate System. Under ‘Extent’ click on the second icon and select the input 
raster (the top/left/right/bottom coordinates will then be filled out automatically). Select the 
input raster under ‘Cell Size’ and select ‘Preserve Resolution’ under Cell Size Projection 
Method, and select the input raster under ‘Sanp Raster’. 
 

 

Figure 2.31  
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2.34 You may find that it is worth exporting the raster from the project geodatabase to your 
Bathymetry folder, so that it can be shared, or more easily imported into other projects. 
Right-click on the newly created raster in the table of contents and go to Data > Export 
Raster. Select the appropriate output location folder (your Bathymetry folder), and you 
should be able to leave most other fields as the defaults (you can leave the format as 
TIFF). You may want to ensure that the cell size fields are integer values if they have 
included a lot of decimals (e.g., 4 and 4). Click ‘Export’. 
 

 

Figure 2.32 

 
2.35 The exported raster will probably have been automatically added to your map, you may 

want to remove the one from the geodatabase from the map, leaving only one. 
 

 
2.36 If the exported layer has a white background obscuring other elements of your map, right-

click on the raster in the table of contents and open the Symbology panel. In the 
Symbology panel, go to the ‘Mask’ tab, and tick the checkbox next to ‘Display background 
value’. Ensure that ‘No color’ is selected as the fill. The background value is probably 0, 
which is entered by default in the value field, so the background should have disappeared, 
if not, you will have to look at the histogram for the raster dataset to work out which pixel 
value is the background value (where there is an unrealistic spike). 
 

 

Figure 2.33 

 

Now you have a reference map within an ArcGIS Pro project to work from. Save and back 
up. The next stage is to assess which of the legacy seismic data is workable, prepare the 
chosen scanned image(s) for import into ArcGIS, and then make an interpretation. 
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3 SELECT SCANNED LEGACY SEISMIC DATA  

Within your GIS project, look at which seismic lines you may want to use by assessing their 
location relative to the bathymetry – lines which are coincident with bathymetry over most of 
their length will be easier to work with, but that doesn’t mean they will be particularly useful 
scans if the seismic data is very noisy. 

 

Shortlisting which seismic lines are usable in terms of feasibility of geological interpretation may 
take some time and will rely largely on brief visual inspection of the scanned data. You may 
want to involve a colleague(s) to help you assess whether a scan can be interpreted for your 
purpose. Ideally, you would include as many of the scans as possible within your region of 
interest. 

 

3.1 To assess the scan, you’ll need to identity one you’d like to query, use the ‘Explore’ tool to 
left-click on the line (one of the line features in the ‘Seismic_Reflection’ layer/shapefile) to 
bring up its attributes. You will see “CRUISE_LIN” make a note of this for the line(s) you 
want to work with. For example, the line shown below is 1970/3#52. 
 

 

Figure 3.1 

 

3.2 Each line may have multiple seismic data types associated with it. In the example above, 
though only one line was selected, the Pop-up shows ‘Seismic_Reflection (3)’, so there are 
3 different elements detected at the same line location. The one that is currently selected 
is the ‘Transit Sonar’ line, which is shown in the ‘GEOPHYS_EQ’ field. 
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3.3 In the Pop-up, look at which data are associated with the line location. You may be 
interested in different data types depending on your specific goal. For the example in this 
report, we are interested in the ‘Sparker’ data. Select the identified data which has 
‘Sparker’ in the ‘GEOPHYS_EQ’ attribute field. 
 

 

Figure 3.2 

3.4 Scroll down in the Pop-up to the ‘SCAN_URL’ attribute field, where there will be a 
hyperlink to where the scanned seismic data is stored online. Click on the link, which will 
open the scan viewer in your default web browser. 
 

 

Figure 3.3 
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3.5 The page that opens will look something like the example below. Here you can zoom in 
and out, scroll around the image and make your own visual assessment of the data to 
determine if you will be able to extract any useful interpretations from it based on the 
image quality. Don’t worry if there are ‘steps’ in the scan where it doesn’t line up along the 
length – you will be able to work around this by splitting the image. 

 

 

Figure 3.4 

3.6 If you are confident that the scanned data will provide useful information, go back to the 
GIS project, and in the Pop-up, scroll down to the ‘SCAN_DOWNL’ attribute field. Click on 
the link there, which will take you to the download page online, agree to the terms and 
download, 
 

 

Figure 3.5  
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3.7 The file will be downloaded to your Downloads folder by default. In your 
Datasets/Scanned_Seismic folder within your project space, create a new folder called 
‘Raw_Scanned_Seismic’. Move your downloaded scan file into this new folder. 
 

 

Figure 3.6 

 

 

3.8 Rename the scan file with the line name and data type (but do not include the / or # in the 
file name). For example CRUISE_LIN 1970/3#52, GEOPHYS_EQ Sparker becomes 
‘Sparker_1970_3_52’. 
 

 

Figure 3.7 

 

 

3.9 The next step is to prepare the scanned image for import into GIS. To do this you will need 
to use drawing software, such as CorelDraw or Adobe Illustrator. For the example in this 
report, we will use CorelDraw. 
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3.10 Open CorelDraw and create a new document (the default document settings are ok for the 
purposes of this exercise). Drag and drop the scanned seismic .jpg2 file into blank page (it 
may take a few moments for the image to load on the page). 
 

 

Figure 3.8 

 

 

3.11 Create another new folder in your Datasets/Scanned_Seismic folder called 
‘Image_Prep_CorelDraw’ save your CorelDraw file to this location with the same name as 
the name you gave to the scan, but with the suffix ‘_prep’. 
 

 

Figure 3.9 
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3.12 If the data has “steps”, where the grid lines long the length of the image do not line up (as 
is the case for the example here), you’ll need to duplicate the image and then use the crop 
tool, probably multiple times, so that you have a series of separate images without these 
steps. 
 

 

Figure 3.10 

3.13 Each segment of the image you now have will need to be exported as separate image. 
First create another new folder within your 
Datasets/Scanned_Seismic/Image_Prep_CorelDraw folder space and call it the name of 
the seismic line you’re working on, with the suffix ‘_noref_jpegs’. 
 

 

Figure 3.11 
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3.14 Starting with the image that was cropped from the first part of the seismic line, select the 

single image in CorelDraw, then go to ‘File > Export’. Navigate to the folder you just 
created, ensure that the ‘Selected only’ checkbox is ticked, and give the export the name 
of the seismic line with the suffix ‘_part1’, make sure that the ‘Save as type’ is set to ‘JPG – 
JPEG Bitmaps..’, Save. The default settings in the dialogue that appears should be ok, but 
you might decide to change the quality from ‘High’ to ‘Highest’, click OK.  
 
Repeat this process for all of the other image segments you have for as many parts as you 
need. If you only have one part (if there were no ‘steps’) just save the one image. 
 

 

Figure 3.12 

 

The next stage will be to import these images into your GIS project and “georeference” 
them to a pseudo map space that approximates a distance versus two-way-time plane, 
from which picks can be made returning X (distance) Y (TWT) coordinates. Those picks 
can then be ultimately converted to XYZ (X – Easting; Y – Northing; Z – TWT) points to be 
gridded. 
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4 ADD SPATIAL REFERENCE TO SCANNED SEISMIC  

 

The next aspect of this workflow will be carried out within your GIS project. 

 

4.1 Within your GIS project, go to the Insert tab and click on ‘New Map’. Change the name of 
this map to the name of the Seismic line you are going to work on – in the example 
detailed in this report – Sparker_1970_3_52. 
 

4.2 Remove the ‘World Topographic Map’ and the ‘World Hillshade’ layers from the map so 
that you have a blank canvas. 
 

 

Figure 4.1 
 

4.3 Right-click on the map name in the table of contents, go to properties and select 
Coordinate System, select a projected coordinate system that uses metres as the map unit  
e.g., British National Grid. 
 

 

Figure 4.2 
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4.4 At the bottom of the map window, click the drop-down arrow next to where the cursor 
location is displayed and change the display units to metres. 

 

 

Figure 4.3 

4.5 Click on the ‘Map’ tab in the top ribbon of your project and select ‘Go To XY’ from the top 
ribbon in the ‘Navigate’ tab. Change the units from the default ‘dd’ to ‘Metres’ and enter 0 
for both X and Y and press enter. 

 

Figure 4.4 

This map space is now ready to add a pseudo-spatial reference to the JPEGs from the 
scanned seismic you created in section 2.3. 
 

4.6 Open the Catalog Pane (if it was closed you will need to go to the View tab and click on 
Catalog Pane). Within the Catalog Pane, Expand ‘Folders’ and expand the folders using 
the small arrows to navigate to where you exported your JPEGs from CorelDraw. 
 

 

Figure 4.5  
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4.7 Check which of the image files (jpegs) clearly has a number of horizontal and vertical grid 
lines – this will be important for the following georeferencing process – and choose one of 
these images to work on first. Drag and drop your chosen first image into the map space. 
Click Ok if you are asked to Build Pyramids. 
 
Right-click on the image in the table of contents and zoom to layer. 
 

 

Figure 4.6 

4.8 Have a look at the original image for the scan, somewhere, probably on the left-hand side 
of the image, there may be an information box with some hand-written details. The 
important information to make a note of here is the ‘T. Marks’ – which tells you the two-
way-time interval at which the horizontal grid lines are drawn. In Figure 4.7 below, the 
example on the left shows that the interval is 40 ms, whereas the example on the right for 
data from a different cruise, indicates that the interval for that data is 100 ms.  
 
Be careful and check through the data you are using thoroughly to ensure you use 
the right interval for your data. This report will use the data with 40 ms intervals as 
the example. 

 

Figure 4.7  
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4.9 In your GIS project, on the map space for the seismic line, zoom in on the image to where 
you see the grid lines, you should see labels for the vertical grid lines. These labels refer 
back to the ‘Shot_Points’ shapefile you have plotted in your Reference_Map, specifically 
the ‘FIX’ attribute of that shapefile. In the example below (Figure 4.8) the label ‘52/2’ refers 
to the Shot_Points shapefile feature with attributes: CRUISE_LIN 52 and FIX 2 (cruise line 
52, shot point 2). 

 

Figure 4.8 

4.10 To check this, go to your Reference_Map in your GIS project, right-click on the 
Shot_Points layer and open the attributes table. In the attributes table, right-click on the 
‘CRUISE_LIN’ column, and click on ‘Custom Sort’.  
 

 

Figure 4.9 

4.11 In the dialogue box that opens, choose ‘Ascending’ as the Sort method for ‘CRUISE_LIN’, 
and then add ‘FIX’ as the second field, and choose ‘Ascending’ as the Sort method for this 
as well. Click OK. 
 

 

Figure 4.10  
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4.12 Scroll down in the attributes table to the CRUISE_LIN you are working on – in this 
example, 1970/3#52. The important things to note here are the coordinates that relate to 
the shot points at the vertical grid lines on your scan that you are going to use to add a 
spatial reference. Specifically the X_BNG and Y_BNG coordinates. 
 

 

Figure 4.11 

Now that you know where to find the relevant coordinates, you can begin adding the initial 
spatial reference for the image. Note that this process uses a ‘fudge’ whereby the X and Y 
positions you add to the map are a proxy for XZ coordinates of the vertical plane of the 
seismic section. Later outside of GIS you can convert the coordinates into XYZ. However, also 
note the caveat that this process assumes that the seismic line you’re working with is a straight 
line (small deviations from a straight line are acceptable for this purpose, but if the section is 
dog-legged it should be slit up into approx. straight-line segments). 
 

 
4.13 Make sure the jpeg you want to add the spatial reference to is selected in the table of 

contents and then go to the ‘Imagery’ tab in ArcGIS Pro’ and click on ‘Georeference’. Click 
on ‘Add Control Points’. Zoom in on the intersection of the grid lines at the first shot point 
and click once. 
 

 

Figure 4.12  
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4.14 Right-click and a ‘Target Coordinates’ dialogue will open. For the X coordinate, enter 0 
(assuming your control point is at the first shot point). The coordinates will be converted to 
the true coordinates later. 
 
For the Y coordinate, there is some more ‘fudging’. For the example in the image for step 
4.13, the control point has been added at the first ‘T.Mark’ after the record start, so at 
40 ms for this scan. However, given the length of the image and the vertical exaggeration, 
enter a value that will preserve a useful aspect ratio for the image. So, a suggestion 
would be 10x the ms value. Additionally, we want to the values to represent elevation in 
time, so they should be negative (this will be important later and to ensure the image 
doesn’t flip upside down).  
 
Enter your value (e.g., -400 for the example) for the Y coordinate. Press OK. 
 

 

Figure 4.13 

 
4.15 Scroll to the other end of the image and find another point where the grid lines cross. Look 

at what the shot point number is – double check the shot point numbers on adjacent 
vertical grid lines, because the handwriting may be difficult to decipher e.g., in the example 
below (Figure 4.14) the shot point number is 16. 
 

 

Figure 4.14  
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4.16 Getting a useful X value for this second shot point location and subsequent locations is 
more involved. Go back to the attributes table for Shot_Points (as in step 4.12) and make a 
note of the X_BNG and Y_BNG values for this shot point (as well as the first shot point or 
the first shot point that you added a control point for). 
 
For the example here (Figure 4.15), shot point 1 has: X_BNG 309307.5943 Y_BNG 
868540.43212; and shot point 16 has: X_BNG 337677.60968 Y_BNG 890563.66588. 

 

Figure 4.15 

4.17 To ensure you avoid any errors that may be the result of poor positioning when the shot 
point locations were originally recorded during data acquisition (during the cruise), double 
check that the points match (at least to within a few metres). To do this, find the shot 
point(s) you have selected on the map, right click on one using the select tool and go to 
copy coordinates – you can then paste these in excel/word, and check the ones from the 
attributes table against them. If significantly different – use the coordinates copied this 
way, as you know they will match the line feature’s position (important for matching to the 
bathymetry later on). 

 

Figure 4.16 

4.18 The distance along the line between the these points needs to be calculated by 

√(∆𝑥)2 + (∆𝑦)2 so i.e., ((337677.60968 - 309307.5943)2 + (890563.66588 - 

868540.43212)2)1/2 = 35914.90774 
 
Note that you may need to think carefully about the orientation of the line, the 
example provided here is simple, because both X and Y increase as the shot point 
value increases, but this may not always be the case e.g., a different survey line may 
have been acquired from north-east to south-west. In cases where X and/or Y 
decrease as shot points increase, you just need to find the absolute value of ∆𝑥 and ∆𝑦 but 
keep a note of the orientation for later on when you come to convert your pseudo spatial 
information to the true XY coordinates.  
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4.19 Repeat steps 4.13 and 4.14 for the second grid line intersection (shot point 16 in the 
example Figure 4.14) and use the value calculated in step 4.17 as the X coordinate.  
 
If you use another shot point other than the first shot point where the X value was 
ultimately 0 to make your calculation, remember to add the result to the X value of the shot 
point you are using instead, so that the X values are always increasing (see step 4.22 for 
more explanation).   
 

 

Figure 4.17 

 

4.20 Now you need another two control points at depth. Use the same vertical grid lines, but the 
deepest horizontal grid line. Count the number of horizontal grid lines to calculate the 
elevation in time. In the example here, the deepest horizontal grid line (T. Mark) is 6 from 
the record start, so 6 x 40 ms – 240 ms, so -2400 should be entered as the Y coordinate. 
 

 

Figure 4.18  
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4.21 Save the Georeference using the save button in the top ribbon. Then Close Georeference. 
 

 

Figure 4.19 

 
 
4.22 If you split the line into segments (because there are steps/scan offsets/scaling issues, but 

the line is still straight) then repeat for the other segments on this same map.  
Close the georeference toolbar, click on the next image you want to georeference then 
open the georeferenced toobar again. Note you will have to work out the offset for the shot 
points as you did for step 4.16 and 4.17. You may want to use an excel sheet as an aid. 
 

 

Figure 4.20 

 

 

4.23 You may notice the vertical grid lines are a bit hit and miss on the scans, so you’ll 
have to use your initiative, but try to use vertical grid lines that are as far apart as 
possible for your georeferencing control points.  
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4.24 If you are using the same line as in the worked example detailed in this report, and 
assuming you downloaded the same coverage of the Seismic_Reflection and Shot_Points 
shapefiles to get coordinate values for the full length of the scan, you should end up with 
something that looks like the image below. 
 

 

Figure 4.21 

 

4.25 Check that the horizontal grid lines line up as you’re expecting. There may be gaps 
between your different images, but this is expected. 
 

 

Figure 4.22 

 
 
The next step is to quality check this against the seabed and adjust the vertical 
georeference values based on the mistie – the bathymetry data is likely referenced to a 
lowest astronomical tide (LAT) datum, whereas the seismic data datum maybe somewhat 
arbitrary. 
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4.26 The original Seismic_Reflection shapefile coordinate system is decimal degrees, which is 
problematic for the next step. To avoid issues, we need to create a new shapefile, by 
creating a new line feature. 
 
In the Catalog pane, find your Datasets/Scanned_Seismic folder, right-click on it, then go 
to ‘New > Folder’. 

 

 

Figure 4.23 
 

Rename the folder ‘Scans_w_spatial_info’ 
 

 

Figure 4.24 

 

Right-click on your newly created folder and go to New > Shapefile. 
 

 

Figure 4.25 
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4.27 This will open the ‘Create Feature Class’ Dialogue. In the ‘Feature Class Name’ field, give 
an appropriate name, e.g., ‘Seismic_w_ref’. Make sure the ‘Geometry Type’ is set to 
‘Polyline’. Change the ‘Coordinate System’ to ‘British National Grid’ (use the globe icon to 
find the coordinate system). Leave the rest of the settings as the defaults. Click Run. 
 

 

Figure 4.26 

4.28 Now you will want to copy the line feature that relates to the scan you’ve been working on 
from the original Seismic_Reflection shapefile into this new shapefile. 
In your Reference_Map use the select tool to select the individual line feature for the 
seismic line from the Seismic_Reflection layer, which will highlight it light blue, make sure 
you only have the one line feature selected (you may want to turn off the ‘Shot_Points’ 
layer to avoid accidentally selecting features from this layer). Whilst the feature is selected, 
go to the ‘Edits’ tab from the top ribbon and click on ‘Copy’. 

 

 

Figure 4.27  
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4.29 Make sure that your new shapefile layer is turned on then use the drop-down arrow under 
‘Paste’ to select ‘Paste Special’, a small dialogue box will open, select Layer, and make 
sure your new Shapefile layer (Seismic_w_ref) is selected from the drop down menu. 
Press OK. 

 

Figure 4.28 

4.30 Click on the ‘Finish’ icon – the square with a tick in it that appears. 

 

Figure 4.29 

4.31 Turn off your original ‘Seismic_Reflection’ shapefile layer, then use the ‘Clear’ button in the 
Selection tools, to deselect your line. You should see that your new shapefile layer has the 
one line you copied. Save the edits using the save button under the edits tab. 

 

Figure 4.30  



Part 4 – Add Spatial Reference to Scanned Seismic 

39 

 

4.32 The attributes for the line you copied, probably did not copy over (even if you had the 
‘Keep source attribute values’ checkbox ticked).  
 
Right-click on the Seismic_w_ref shapefile in the table of contents and open the attributes 
table. Next to ‘Field:’ click on ‘Add’. A new tab will open to allow you to edit field names. 
 
For the new field (which will be automatically selected) enter ‘CRUISE_LIN’ for both the 
‘Field Name’ and the ‘Alias’. Change the ‘Data Type’ to ‘Text’ using the drop-down. 
 
You can move through the cells using the tab button on your keyboard. Save using the 
button at the top of ArcPro. Close the ‘Fields’ tab.  
 

 

Figure 4.31 

 

4.33 In the attributes table, select one of the rows and then double click in the input box under 
the ‘CRUISE_LIN’ field. Enter the name of the seismic line, you can either keep this the 
same as the original, or your updated version e.g., 1970/3#52 or 1970_3_52.  
 
You may have three separate features (for the different data types: Sparker/echo sounder 
etc), but this line feature is just to have a line in the same location with more workable 
coordinates, so you can delete duplicates, so you only have one feature for the line. Save 
the edits again. 
 

 

Figure 4.32 
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4.34 The purpose of creating this new line feature is to extract the seabed two-way-time values 

where you have data along the length of the line. 
 
Use the select tool to select the line feature, then go to ‘Tool’ from the ‘Analysis’ tab, and 
search for ‘Stack Profile’. 
 

 

Figure 4.33 

 

4.35 In the Stack Profile dialogue, select your newly created shapefile as the ‘Input Line 
Features’ and ensure that the ‘Use the selected records’ switch is turned on – you should 
see that it says 1 record is selected. 
 
 Select your two-way-time bathymetry as the Profile Target (note you can select multiple 
raster targets, should you need to extract other data using this tool). 
 
Use the folder icon next to the ‘Output Table’ to navigate to your 
Datasets/Scanned_Seismic folder, then create a new folder called ‘Bathy_Along_Profile’, 
go into this new folder and then save the table as the CRUISE_LIN name, but with the 
prefix ‘Bathy_’ e.g., ‘Bathy_1970_3_52’. Click ‘Run’ on the Stack Profile dialogue. 
 

 

Figure 4.34 
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4.36 The table should have appeared in the table of contents, right-click on it and select ‘Open’. 
Click on the grey space in the table window, then use Ctrl + A on your keyboard to select 
all and then click on ‘Copy’. 
 

 

Figure 4.35 

4.37 Open Microsoft Excel and create a new blank document. Either use Ctrl + V or right click 
on the first cell and paste to paste the table from ArcGIS. 
 

 

Figure 4.36 

4.38 Delete all the columns except for ‘FIRST_DIST’ and ‘FIRST_Z’. 

 

4.39 In a third column, which you could call ‘Ref_Elev’, calculate FIRST_Z * 10000 (x1000 to 
convert seconds to milliseconds, and an additional factor of 10 for the ‘fudge’ factor used in 
step 4.14). Copy the cells from this column, and paste back in the same place as values 
only by right-clicking and selecting ‘Values’ under the paste options.  

 

 

Figure 4.37 
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4.40 Go to File > Save As.. and save the excel sheet as a ‘Text tab delimited’ file in your 
Datasets/Scanned_Seismic/Bathy_Along_Profile folder, with the same name as the table 
in your GIS project. 

 

 

Figure 4.38 

 

 

4.41 Go back to your GIS project and open the map for the scan you are working on (e.g., the 
Sparker_1970_3_52 map). Click on the Map tab from the top ribbon and then use the 
drop-down under ‘Add Data’ to select ‘XY Point Data’ 
 

 

Figure 4.39 
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4.42 In the ‘XY Table To Point’ dialogue, use the folder icon next to the ‘Input Table’ field to 

select the text file you’ve just created (you may have to refresh the explorer window). Use 
the folder icon next to the ‘Output Feature Class’ field to navigate to the same folder where 
you saved your text file, then create a new folder in that space called ‘Shapefiles’ (this is 
just to keep your folder space well-organised), then save with the same name as the initial 
text file, but add the suffix ‘_topoint’. 
 
Select ‘FIRST_DIST’ as the ‘X Field’ and ‘Ref_Elev’ as the ‘Y Field’. Change the 
Coordinate System to British National Grid (or ‘Same as current map’ assuming you are on 
your map for the scan). Click Run. 

 

Figure 4.40 

4.43 You should see that the points have been imported and that they sit approximately on the 
seabed on your spatially referenced scanned image (you might want to alter the 
symbology to make the position of the points clearer). If they look like they are flipped 
the wrong way round compared to your scanned data – see below for the fix. 

 

Figure 4.41  
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4.44 The Stack Profile tool returns data where ‘FIRST_DIST’ from the start point of the line that 
was selected in the process, this depends on the way the line was drawn (or calculated in 
ArcGIS if generated from coordinate points). This means that if the line was ‘drawn’ from 
west to east instead of east to west, the points may appear flipped compared to your 
georeferenced scan. See example in Figure 4.42 

 

Figure 4.42 

 

4.45 To correct the flip, reopen the table you created in steps 4.39 and 4.40 for the extracted 
bathymetry. In a 4th column, which you can just call ‘X’ you want to calculate the reverse of 
the ‘FIRST_DIST’ values. Do this by either finding the max value of the ‘FIRST_DIST’ 
column, or using that cell in the formula as depicted in Figure 4.43. Check that the values 
in the X column make sense – so that the last value is 0. Then copy and paste in the same 
place, but as values only. Save this as a new tab delimited text file, e.g., with the tag 
‘_corrected’. 
 

 

Figure 4.43 
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4.46 Now, repeat steps 4.41 and 4.42, but use this corrected table as the input and select ‘X’ as 
the ‘X Field. You should see that the bathymetry points have flipped to the same 
orientation as your georeferenced scan. Note that you may still have offsets, as in the 
example shown below in Figure 4.44. These offsets probably relate to errors in labelling of 
the paper records, you can shift/stretch the scan to match the bathymetry to ‘correct’ for 
this. 

 

Figure 4.44 

Note that the general geometry should fit the seabed reflection in your scan, but there will be 
deviations. Most notably that the seabed is likely mobile and there is a large time gap between 
when the seismic data and the bathymetry data were acquired. Additionally, there will be some 
errors introduced from how straight/wiggly your seismic line is in map view. However, there are 
two systematic errors that can be corrected for. 
 

4.47 If there is what looks like a large lateral offset as in Figure 4.44 (if not then skip this step), 
then click on the scan in the table of contents, then go to the ‘Imagery’ tab and click on 
‘Georeference’. Open the ‘Control Point Table’. Then use a process of trial and error to edit 
the ‘Map X’ values until you get a good match between your scan and the bathymetry 
(don’t edit the ‘Map Y’ values – see below for this correction). Stick to round numbers e.g., 
to nearest 100 map units. You can choose a different amount of shift for the left- and right-
hand control points, but make sure that the Map X values are the same for the same shot 
point position (where they are aligned vertically). Save your edits. Close the 
Georeferencing toolbar. 

 

Figure 4.45  
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4.48 There may also be a consistent offset where there is a difference between the LAT datum 
of the bathymetry and the datum used for the seismic – this difference we can correct for. 
 

4.49 Use the measure tool in the inquiry section of the Map tab to measure the vertical distance 
between the seabed points you just imported and the seabed reflection on the 
georeferenced scan. Measure at a number of different places along the scan and make a 
judgement about what a general average offset value is. 
 

 

Figure 4.46 

4.50 Once you’ve determined an approximate value, you’ll need to alter the spatial reference for 
the scanned seismic. For the example here, after a few measurements along the profile, 
the general vertical offset is around 80 map units – referring back to what we have done in 
this work flow, that corresponds to an offset of 8 milliseconds two-way-time. 
 
To make the correction, click on one of the scan jpegs in your table of contents, go to the 
’Imagery’ tab from the top ribbon, then click on ‘Georeference’. Click on ‘Control Point 
Table’. This will open a table at the bottom of the map window showing the X and Y values 
you entered for the grid line intersections for the scan. Change all the values in the ‘Map Y’ 
field by the value you determined in step 4.49 (make sure you change the values in the 
right direction to ensure your scanned image shifts towards the bathymetry points). Save 
your edits. Close the Georeferencing toolbar (you need to do this so you can edit the 
georeferenced you have for any other jpegs for the scan). 

 

Figure 4.47 
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4.51 Repeat step 4.50 for each jpeg you have for the scan. Check that your grid lines all line up 
and that no unexpected warping has happened to your image – if you notice something 
odd, you may have accidentally entered a value for the Map Y that wasn’t consistent with 
the alteration you want to apply. Make sure you apply the same alteration/shift to all 
your jpegs that make up one scanned record (if you had to segment) even if some 
do not have any overlap with the bathymetry points. 
 

4.52 You should now see that your scanned image sits nicely aligned with the bathymetry 
points. 
 

 

Figure 4.48 

The scanned seismic is now ready for interpretation! If you prefer however, you may want 
to repeat the process from section 3 up to this step, to add more maps with spatially referenced 
scans before you get started. Note, many of the steps, particularly those that relate to creation 
of new folder, can be skipped now that you have completed the process for the first scan. 
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5 MAKING INTERPRETATION PICKS FROM THE SCANNED SEISMIC DATA 

5.1 Adding Borehole Information 

Once the scanned data has been prepared with a pseudo-spatial reference, you can being 
making an interpretation of the geology. To assist with this, you may want to consult the 
borehole records from the BGS Offshore Geoindex. Access the offshore geoindex here: 
https://www.bgs.ac.uk/map-viewers/geoindex-offshore/. 

Note that not all seismic lines will intersect with a borehole, and that many of the borehole 
records may also be legacy scans.  

5.1 On the Geoindex, turn on the ‘Borehole: Activity & Scan’ layer under ‘Sample Data’ along 
with the ‘Seismic Reflection’ layer. Find the seismic line that relates to the scan you want 
to work on by left clicking on the lines. Then find where the line intersects a borehole 
record. Click on the borehole point and it will open a small information box, which may 
have a link to a PDF, which you can open to see what the borehole records contain. 
 

 

Figure 5.1 

 

5.2 You may also want to download a shapefile for the borehole locations to add to your GIS 
project. Turn off the Seismic Reflection layer on the Geoindex, and turn on the ‘Borehole: 
Geology Data’ so you have both the ‘Borehole: Activity & Scan’ and ‘Borehole: Geology 
Data’ layers turned on. Follow the same process outlined in steps 2.6 to 2.10 to download 
the data. 
 

 

5.3 In your Datasets folder, create a new folder called ‘Boreholes’, and create another folder 
within this one called ‘Shapefiles’. Extract the data you downloaded to this shapefiles 
folder. 
 

 

  

https://www.bgs.ac.uk/map-viewers/geoindex-offshore/
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5.4 Go to your GIS project and click on the Reference_Map. Navigate to the 

Datasets/Boreholes/Shapefiles folder in the Catalog Pane (you may need to right-click on 
the Datasets folder and Refresh). Drop the two shapefiles (not the layer files into your 
map). 
 

 

Figure 5.2 

 
 
5.5 You can use your ‘Seismic_w_ref’ shapefile layer, which you created to show the position 

of the scan(s) you have been working on to see where boreholes are intersected. 

 

 

 

Figure 5.3 
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5.6 Turn off the ‘Borehole__Geology_Data’ shapefile layer, leaving the 
‘Borehole__Activity_and_Scan’ shapefile layer turned on. Use the ‘Explore’ option from the 
Map tab to click on the point that relates to a borehole you want to query. Scroll down in 
the info box that appears to the X_BNG and Y_BNG fields and make a note of the values. 
Also make a note of the ‘WATER_DEPT’ field value. 

 

Figure 5.4 

5.7 In this case the values are: X_BNG 373719; Y_BNG 919768; and WATER_DEPT 60.  
Note that the water depth may not be corrected for metres below lowest astronomical tide 
(mLAT), but this can be dealt with later. 
Using the same method as in step 4.17. We can calculate the offset of the borehole from 
the first shot point of the seismic line that was spatially referenced, so we can determine 
how far along the profile the borehole sits (approximately – note that the borehole may not 
sit directly on the seismic line). In this case the formula would be: 
((373719 - 309307.5943)2 + (919768 - 868540.43212)2)1/2 = 82298.8025 
 
This provides an X value in distance along profile, which we can use to add borehole 
information to the GIS map with the spatially referenced scan. 
 

5.8 In the Pop-up for the borehole point that opens when you query it with the explore tool, 
scroll down to the ‘IMAGE_URL’ field and click on the link. The scanned PDF (if it exists) 
will open in your default browser. 

 

Figure 5.5  
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5.9 Open a blank Microsoft Excel document where you can transfer selected geological 

information. You may want to follow a similar format to the example below. Use the 
formula shown below to convert the depth below seafloor into two-way-time. This assumes 
a constant velocity below seabed of 1700 ms-1. Then apply the x10000 ‘fudge’ factor to 
another column. Once you are happy with the values in the TWT and TWT_fudge 
columns, copy and paste in the same cells as values only. Change the fudge values to 
negatives. 

 

Figure 5.6 

 

5.10 Go to File > Save As.. and save the excel sheet in your Datasets/Boreholes folder with a 
name that includes the name of the borehole, and a reference to the seismic line (because 
the X values relate to a specific spatial reference), save as a Text (tab delimited) file. For 
example:  CL1970_3_52_58-003-96-BH-1.txt. 
 

 

5.11 Close the Excel sheet and go back to your GIS project and the relevant Scan map. From 
the ‘Map’ tab, use the drop-down under ‘Add Data’ to select ‘XY Point Data’. Use the folder 
icon next to the ‘Input Table’ to select the text file you created (you may need to right-click 
and refresh the folder space). Use the folder icon next to the ‘Output Feature Class’ field to 
navigate to your Datasets/Boreholes/Shapefiles folder and save the file with the same 
name as the input table, but if there is character space you could add the suffix ‘_tops’. 
Select ‘Profile_X’ as the ‘X Field’ and ‘TWT_fudge’ as the ‘Y Field’, change the coordinate 
system to ‘Current Map’ or British National Grid. Click Run. 

 

 

Figure 5.7 
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5.12 You should see that the points have plotted nicely on your seismic section. You can click 
on the symbol icon under the name of this points layer in the table of contents to change it 
to something that will be more visible. 
 
You can also label the points with the information you included in the spreadsheet. Right-
click on the layer in the table of contents and go to ‘Labelling Properties’. Double click on 
‘Top’ under fields so that the Expression box shows ‘$feature.Top’. Click Apply. You can 
also change the label symbol using the symbol tab (you might want to increase the font 
size and choose a bright colour). 

 

Figure 5.8 

5.13 Right click again on the layer in the table of contents and click on ‘Label’ (see above). You 
should see that the points are now labelled with the geological information you included, so 
that the points represent the top of geological layers. 
 

 

Figure 5.9  
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5.14 If the geological layer that starts at the seabed shows an offset from your bathymetry 
points that you deem to be significant, you can correct for this. First, use the measure tool 
to determine what the offset is. 

 

Figure 5.10 

5.15 Go to the ‘Edit’ tab from the top ribbon and use the ‘Select’ tool to select one of the points, 
then click on ‘Modify’ this will bring up a list of edit options on the right-hand side of ArcPro. 

 

Figure 5.11 

5.16 Select the ‘Move To’ tool. This will bring up a dialogue that shows the X and Y position of 
the point that you have selected. Here, you can modify the Y value based on your 
measurement in step 5.14. In the example, the original measurements was ~-805, and we 
want to shift the point up by ~25 map units, so the value to enter is -780. When happy, 
click on ‘Move To’ at the bottom of the dialogue. This will shift the point to the seabed. 

 

Figure 5.12  
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5.17 It’s important to then apply the same vertical shift to all your borehole points using the 
same tool. You may also want to change the values in the table of attributes, but this is not 
necessary. 
 

 

Figure 5.13 

5.2 Horizon Interpretation 

Now you have some borehole information to aid your seismic interpretation. The next step is to 
create a line feature for a horizon interpretation. 

 

5.18 Go to your Scanned_Seismic_Project folder space in windows explorer and create a new 
folder called ‘Horizon_Interpretations’. 

 

Figure 5.14 

5.19 In your GIS project, find the folder you’ve just created in the Catalog Pane. You may have 
to right-click on ‘Folder’ and ‘Add Folder Connection’. 

 

 

Figure 5.15  
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5.20 Right-click on the ‘Horizon_Interpretations’ folder and go to ‘New’ > ‘Shapefile’. 
 

 

Figure 5.16 

 
5.21 In the Create Feature Class dialogue, add a name for the horizon you want to interpret – 

for example ‘Top_of_Bedrock’ (note you probably want to include some reference to the 
cruise line name for the seismic), change the ‘Geometry Type’ to ‘Polyline’, change the 
‘Coordinate System’ to ‘Current Map’ (or British National Grid). Click Run. The new feature 
will have appeared in the table of contents. Click on Save in the ‘Manage Edits’ section of 
the Edit tab. 
 

 

Figure 5.17 

  



Part 5 – Making Interpretation Picks from the Scanned Seismic Data 

56 

 

5.22 To make picks for your interpretation, from the Edit tab, click on ‘Create’ from the 
‘Features’ section. The ‘Create Features’ pane appears on the right, where you can see 
the editable layers. Select your horizon feature, and the picking/drawing options will be 
displayed. You probably will only need the ‘Line’ option. 
 

 

Figure 5.18 

 

 
5.23 You can now make horizon picks in the map window. You can start and create as many 

new lines as part of the same feature as you feel you need – but these will have to be 
merged into one feature later. Make sure that your lines do not overlap, small gaps 
between them are ok. 
 

 

5.24 If required, you can go to the Edit tab, click on ‘Modify’ and then choose ‘Edit Vertices’ to 
move picks if you want to make alterations. 

 

Figure 5.19 
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5.25 You can periodically save your edits using the ‘Save’ button under ‘Manage Edits’. 

 

Figure 5.20 

 

5.26 If you have multiple line segments, use the ‘Select tool’ to select all of the lines that relate 
to the horizon you are interpreting. From the ‘Tools’ section of the ‘Edit’ tab, select ‘Merge’. 
Click ‘Merge’ at the bottom of the dialogue pane that opens. 

 

Figure 5.21 

 

5.27 When you open the attributes table for your horizon feature, you should see that there is 
only one line feature within it. Remember to save your edits. 

 

Figure 5.22 
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6 EXTRACT PICKS AND CONVERT TO GEOSPATIAL DATA 

6.1 Once happy with the interpretation, the next step is to begin extracting the data. To do this 
go to ‘Tools’ from the ‘Analysis’ tab, then search for ‘Feature Vertices To Points’ and open 
the tool. 

 

Figure 6.1 

6.2 Under ‘Input Features’ select your interpreted horizon, under ‘Output Feature Class’ use 
the folder icon to navigate to your ‘Horizon_Interpretations’ folder, and save with the same 
name, but add the suffix ‘_p’ for points. Make sure that ‘Point Type’ is set to ‘All vertices’. 
Click Run. The points will appear in the table of contents. 

 

Figure 6.2 

6.3 Go back to ‘Tools’ from the ‘Analysis’ tab and this time search for ‘Add XY Coordinates’ 
and open the tool. Under ‘Input Features’ select the points layer you have just created. 
Before you run the tool, go to the ‘Environments’ tab within the tool and change the ‘Output 
Coordinate System’ to British National Grid. 

 

 

Figure 6.3 
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6.4 Open the attributes table for the points feature and you should see that there is now a 
‘POINT_X’ and ‘POINT_Y’ field. Click in the grey space to the right of the table and use 
Ctrl+A on your keyboard to select all, then click on ‘Copy’. 

 

Figure 6.4 

6.5 Open a blank Excel document and paste the data. Delete all of the columns except 
‘POINT_X’ and ‘POINT_Y’. The next step is to convert this data into X, Y, Z format, where 
the Z column is two way time in seconds. The first and easiest step is to convert the 
POINT_Y field to Z. 
 

6.6 The ‘fudge’ in earlier steps, to ensure that a useful aspect ratio for the vertically 
exaggerated seismic is maintained, was to use 100 m vertically for 10 ms. To convert back 
to time in seconds then simply divide the POINT_Y column by 10000 (10 for the fudge, 
1000 for milliseconds to seconds). 

 

Figure 6.5 

 

6.7 Converting the POINT_X into the ‘true’ X and Y coordinates is more complicated. The 
POINT_X values is the distance in metres from the first shot point location along an 
arbitrary straight line. We need to determine some directionality of the line – essentially the 
reverse of the calculation in step 4.17. Get the X_BNG and Y_BNG coordinates of the first 
and last shot point for your seismic line. 
For the example here: 
 
First shot point X_BNG 309307.5943, Y_BNG 868540.43212  
 
Last shot point X_BNG 429947.30097, Y_BNG 965373.54592 
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6.8 We need to work out the change in X_BNG per m along the straight line and the change in 
Y_BNG per m along the straight line. First determine the change in X_BNG and Y_BNG 
from the first to last shot point. 

 

Figure 6.6 

6.9 Now calculate the total length along the line using the formula √(∆𝑥)2 + (∆𝑦)2 (same as in 

step 4.17). 

 

Figure 6.7 

6.10 Then divide the change in X_BNG and Y_BNG by this total distance. 

 

Figure 6.8  
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6.11 In additional columns, now calculate the X_BNG and Y_BNG values for your points by 
multiplying the change per metre values you just derived and then adding the X_BNG and 
Y_BNG values of the first shot point (assuming the first shot point is to the west and south 
of the last shot point – if your line orientation goes from north to south and/or east to 
west you’ll need to work out change in that direction and do a subtraction). 
 
E.g., here X_BNG = (POINT_X * ΔX_BNG/m) + X_BNG_first_shot_point 
Y_BNG = (POINT_X * ΔY_BNG/m) + Y_BNG_first_shot_point 
 

 

Figure 6.9 

 

6.12 You should now have 5 columns, which look like this: 
 

 

Figure 6.10 
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6.13 Check the values against your GIS project to convince yourself that these look correct – go 
back to your reference map and hover the cursor over the rough location of your 
interpretation and look at the coordinate values that are indicated (in example we are 
looking for coordinates near shot point 27). 

 

Figure 6.11 

6.14 Now copy the 5 columns and paste as values only – either in a new sheet or the same one 
(you might want to preserve the first sheet with any formulas so you don’t need to re-enter 
them for the next scanned profile). Remove the POINT_X and POINT_Y columns and 
rearrange so that your columns are in X_BNG, Y_BNG, TWT_s order, add a header mark 
at the beginning of the first cell e.g., > or # so that your excel sheet looks like this: 

 

Figure 6.12 

You may also want to change the sign of your TWT values from negative to positive 
 

6.15 This is now in X, Y, Z format in British National Grid, where the TWT_s is referenced to 
LAT. Save the file in a new folder within your Horizon_Interpretations folder called 
‘XYZ_files’– save as a text delimited file for use in other software, give an appropriate 
name that gives the horizon name and line name. 

 

Figure 6.13  
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6.16 Ultimately, you will want to do this for all of the scans where you are interpreting the same 
horizon, then paste the additional X, Y, Z data all into one file (make sure you only have 
one header line), and then it can be used to grid a surface – and from there, if required, do 
a depth conversion using the bathymetry you have. 
 

6.17 You can quality check the points you have extracted by importing them into your GIS 
project. Go to your Reference_Map and use the drop-down under ‘Add Data’ to select ‘Add 
XY Point Data’. Use the folder icon next to the ‘Input Table’ field to navigate to and select 
the text file you’ve just created. Since this is just a quality check, you could leave the 
default output location and name, or you could change to a new folder such as ‘QC_points’ 
and add a ’_p’ suffix to the name. Select ‘X_BNG’ as the X field and ‘Y_BNG’ as the Y 
field, leave the Z field blank and change the Coordinate System to British National Grid. 
Click Run. 

 

Figure 6.14 

6.18 You should see your points added – note there is probably on offset from the seismic line 
scan (since it probably deviated from a straight line) – for the purposes and resolutions 
we’re dealing with from these data this is not a serious issue/the offset is negligible. 

 

Figure 6.15  



Part 6 – Extract Picks and Convert to Geospatial Data 

64 

6.19 Right-click on the new points layer in the table of contents and go to ‘Symbology’. Use the 
drop-down to select ‘Unclassed Colors’. Use the drop-down next to ‘Field’ to select the 
‘TWT_s’ field, you can play around with a colour scheme that suits you. 

 

Figure 6.16 

 

6.20 The points should now be coloured by their two-way-time value. 
 

 

Figure 6.17 

 

Now that you have an ArcGIS project set up you can keep adding maps for additional 
scans that you want to spatially reference and interpret. Ultimately, you will generate a 
set of XYZ text files for interpreted horizons – these could be imported as grids into 
another 3D data visualisation program for SEGY data such as Kingdom, Petrel, DUG etc. 
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Example Use 

One goal of the BGS Marine Geoscience Program is to update and improve Quaternary 
Thickness maps for the UKCS, which were originally based on spot depths from boreholes with 
sufficient penetration depth and manual drawing of isopachs broadly guided by the early paper 
seismic records. Extracting additional stratigraphic geospatial information from the scanned 
legacy seismic data within a digital georeferenced environment enables capture of more detail 
with greater accuracy and could significantly improve the maps without acquiring new data. 

To ensure that potential scope for using the legacy data is not overestimated, it is important that 
any user has a clear understanding of the limitations. The workflow outlined in this report 
addresses many of the issues associated with positioning of scanned legacy seismic data, 
however, other challenges remain. Primarily, the imaging quality of the original data. For older 
data (e.g., from 1970s cruises), and shallow water depth, there is insufficient suppression of the 
multiple to enable accurate interpretation (Figure 7.1). 

 

Figure 7.1. Example scanned seismic section from area of shallow water in the Moray Firth. Insufficient 
suppression of seismic artefacts, i.e., the seabed multiple, obscures real features. 
 

Issues such as this that relate to the original seismic processing reduce the scope of what is 
achievable with the scanned data, and seismic lines must be carefully chosen to maximise 
reward for the effort to position them in space. Trawling the data for the best images is likely the 
most labour intensive aspect that a user of this report may face. Nevertheless, there are many 
scanned seismic lines that contain very valuable information to be extracted where the imaging 
is good (Figure 7.2). 

 

Figure 7.2. Example scanned seismic line from west of Skye, where there is good imaging of Quaternary 
sediments and the top of bedrock (Rock Head). 
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Figure 7.3. Using scanned legacy seismic data to update the BGS Offshore Quaternary Deposits map, southest of Shetland. (a) The existing BGS offshore Quaternary Deposits Thickness map. (b) Position of extracted scanned legacy seismic 
(sparker) records, and associated shot pots, used for interpretation. (c) Point data showing Quaternary thickness calculated at 1 m intervals along each seismic line where interpretation picks have been made. (d) Calculated thickness from 
interpretation gridded at 2 km spacing (inside the dashed lines) and contoured with the same intervals at the same intervals as the existing Quaternary Deposits Thickness map. (e) Regional location of the area depicted. CRS = Coordinate 
Reference System. Contains an extract from existing Quaternary thickness geological factor map produced as part of collaboration between BGS and The Crown Estate in 2014 BGS © UKRI. Contains OS data © Crown copyright and database 
right 2025. 
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Where there is sufficient coverage of scanned seismic with good image quality, applying the 
methodology may yield substantial new geological data for areas with gaps. Here, we show an 
example from southeast of Shetland, where scanned legacy sparker data consisting of five 
~55 km long north-south lines and six ~70 km long west-east lines, span an area of ~4000 
square kilometres. Spacing between the north-south lines is ~12 km, and spacing between the 
west-east lines is ~6.5 km (Figure 7.3). The data has been chosen based on good coverage, 
the regularly of spacing between the lines, and the imaging quality preserved in the scanned 
images. For this example, no bathymetry data was used, and the primary goal was to 
demonstrate the value of the data to improve resolution of BGS’s offshore Quaternary Deposits 
Thickness (QDT) map. Therefore, the seabed and base Quaternary horizons were picked on 
each line (where possible), and the two-way-time difference calculated and converted to 
thickness in metres to provide a series of point location thickness values along each line, which 
could then be gridded. 

Since the process for extracting the interpretation picks and accurately positioning them in 3-
dimensional space is repetitive, we use a function written in python to generate output XYZ files, 
which could be compiled for gridding. The specifics of the python script and the inputs and 
outputs are detailed in the Appendix. The script is an example but could be adapted to the 
specific needs of a user. 

Figure 7.3 shows the stages of the process by which the legacy data has been employed to 
improve BGS’s QDT map (BGS 2022), which is largely derived from the original 
1:1,000,000 scale UK offshore Quaternary map (Holmes et al., 1993). Part (a) shows the 
existing QDT map, where most of the region depicted is mapped as 5-20 m thickness; Part (b) 
shows the position of the selected legacy seismic data used and the associated shot points; 
Part (c) shows the thickness calculated by subtracting the interpreted base Quaternary horizon 
from the seabed horizon at regular points (picks have been resampled at a regular interval to 
allow easy subtraction – see the Appendix); Part (d) shows the result when the point data is 
gridded at a 2 km spacing and contoured using the same intervals as the existing QDT map; 
Part (e) shows the location. In this example, no borehole data was used directly, due to a data 
gap in currently available records. Other areas could be more thoroughly constrained using 
additional geotechnical data. However, the small subset of data used in this example, when 
compared to the number of scanned seismic lines available across the UKCS, demonstrates 
that significant detail can be added to the existing maps – compare Figure 7.3a and 7.3d. 

Limitations 

Maps generated using this methodology and the legacy data should be transparent about the 
nature of the data and the limitations. 

Much of the legacy data was acquired (pre 1990s) before the adoption of highly accurate global 
positioning systems on survey vessels, such as Real-Time-Kinematics (RTK) for Global 
Navigation Satellite Systems (GNSS), so there may be inherent inaccuracies in the positioning 
of the shapefiles downloaded from the Geoindex. The accuracy of positioning the scanned data 
in the vertical plane (using this workflow) relies on sufficiently legible grid lines and labelling on 
the scanned image and assumes that where such information is available it has been recorded 
accurately during the original preparation of the paper records. The georeferencing process 
detailed in the workflow invites the potential for more human error. For seismic line geometries 
that have deviations from a straight line relative to the spacing between lines (excepting lines 
that have large-scale, obvious dog-legged geometries), it is unrealistic, or not possible, to 
expect to account for these deviations. Therefore, approximations will almost certainly be made 
for the position of interpretation picks, so that they are slightly offset from the true line position 
(see Figure 6.15). In addition, due to the irregularity of spacing between lines, and highly 
variable imaging quality, to generate grids, picks should be smoothed by spatial averaging prior 
to gridding, and the location of the point data should be provided with the final grids as in 
Figure 7.3c. This is to ensure that the constraints (or lack of) for areas between seismic lines is 
made clear. 



 

68 

 

Closing Remarks 

Despite the associated limitations with legacy data/digitised paper records, these data have 
potentially far-reaching value. The example use above demonstrates the value for direct 
updates of existing maps without acquisition of new data. However, using the workflow in this 
report these data could be used to construct initial horizon grids or make a first-pass regional 
geological interpretation before further seismic data acquisition. Initial grids generated from the 
legacy data during a desk-based study, could be added to seismic interpretation software, 
where they can be better constrained by newly acquired SEG-Y datasets, or provide an initial 
guide to the interpreter. 

The repository of open source scanned seismic, along with these instructions for how to extract 
useful geological information using software widely used by universities, expands the potential 
for the data to be used in student projects or blue-sky science, where there is no immediate 
commercial application. In addition, the workflow itself could also be utilised as a training 
resource. We invite potential users to engage with BGS to obtain mutual benefit from any 
outputs that result from application of the workflow or provide suggestions for improvement. 
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Appendix 

Below is an example script for a python function, coded in python version 3.12.4, and using the numpy 
and pandas modules. It’s important to emphasize that this is an example, which could be better refined, 
and/or adapted and updated by a potential user of this report to suit their specific requirements. See 
section below for the format of inputs required for the code to run successfully. 

CODE 

#! python3 

# extract_thickness_metres.py 

 

import numpy as np 

import pandas as pd 

 

def calculate_horizon_depth_mbsf( 

    seismic_line, 

    seabed_csv, 

    horizon_csv, 

    first_sp_x, 

    first_sp_y, 

    last_sp_x, 

    last_sp_y, 

    fudge_factor=10, 

    s_or_ms="ms", 

    first_sp_relative_position="sw", 

    interp_x_uses="x", 

    seis_velocity_m_per_s=1700, 

): 

    """ 

    This script is an example to show how conversion of the points 

    data exported from interpretations made in ArcGIS Pro on scanned 

    seismic can be automated. To address the specific needs of the 

    user, the script will need to be editted. 

 

    The inputs to the function should be as follows (and see 

    example use of function below): 

    seismic_line = a string used to generate the output file name 

    seabed_csv = path to file for a two column csv file with the 

    POINT_X and POINT_Y values for a seabed pick 

    horizon_csv = path to file for a two column csv file with the 

    POINT_X and POINT_Y values for a horizon pick 

    first_sp_x = the easting value for the first shot point along 

    the line for which the data is being converted 

    first_sp_y = the northing value for the first shot point along 

    the line for which the data is being converted 

    last_sp_x = the easting value for the last shot point along 

    the line for which the data is being converted 

    last_sp_y = the northing value for the last shot point along 

    the line for which the data is being converted 

    fudge_factor = the multiplier used to preserve the vertical 

    exaggeration of the scanned seismic in ArcGIS Pro 
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    s_or_ms = either 's' or 'ms' depending on whether the values 

    for the interpretation represent time in seconds or 

    milliseconds 

    first_sp_relative_position = 'sw', 'se', 'nw', or 'ne' - the 

    position of the first shot point (used in the conversion) 

    relative to the rest of the seismic line 

    interp_x_uses = 'x' or 'y' - in the georeferencing, was the 

    x (easting) values used or the y (northing) values used 

    seis_velocity_m_per_s = value for velocity to be used in 

    depth conversion in metres per second 

 

    """ 

    # users specifies whether the twt values are in seconds ('s') or 

    # milliseconds ('ms') in the input, along with the fudge factor used 

    # e.g., x10 to preserve vertical exaggeration in arc for georeferenced 

    # scan. The multiplier of 2 accounts for two-way-time 

    if s_or_ms == "s": 

        time_divider = 2 * 1 * fudge_factor 

    elif s_or_ms == "ms": 

        time_divider = 2 * 1000 * fudge_factor 

 

    # load interpreted seabed data from exported csv file 

    seabed = pd.read_csv(seabed_csv, sep=",") 

 

    # load interpreted horizon data from exported csv file 

    horizon = pd.read_csv(horizon_csv, sep=",") 

 

    # if the seabed and horizon picks were made up of multiple lines within the 

    # feature in arc, they may not be ordered correctly, but they can be sorted 

    # into ascending order 

    seabed = seabed.sort_values(by=["POINT_X"]) 

    horizon = horizon.sort_values(by=["POINT_X"]) 

 

    # resample the seabed and horizon at regular points to enable direct 

    # calculation between seabed and horizon. First check whether the 

    # x (easting) values or y (northing) values where used to georeference the 

    # scan 

    if interp_x_uses == "x": 

        min_x_val = np.min((first_sp_x, last_sp_x)) 

        max_x_val = np.max((first_sp_x, last_sp_x)) 

 

    elif interp_x_uses == "y": 

        min_x_val = np.min((first_sp_y, last_sp_y)) 

        max_x_val = np.max((first_sp_y, last_sp_y)) 

 

    # create an array of values where to resample at (as integer values) 

    sample_x_vals = np.arange( 

        (float(round(min_x_val, 0) + 1)), float((round(max_x_val, 0))), 1 

    ) 

 

    # use an interpolation to resample the picks - note that this will generate 

    # points where there was no original data if there are gaps in the pick. 

    # Gaps may relate to where the horizon pinches out at the seabed (as in 
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    # this example), but for other cases, it may be nessary to split the 

    # interpretation csv file to avoid unwanted interpolation 

 

    seabed_resample = np.column_stack( 

        (sample_x_vals, (np.interp(sample_x_vals, seabed.POINT_X, seabed.POINT_Y))) 

    ) 

 

    horizon_resample = np.column_stack( 

        (sample_x_vals, (np.interp(sample_x_vals, horizon.POINT_X, horizon.POINT_Y))) 

    ) 

 

    # get the change in the easting (as a positive value) 

    dx = abs(last_sp_x - first_sp_x) 

 

    # get the change in the northing (as a positive value) 

    dy = abs(last_sp_y - first_sp_y) 

 

    # get the total distance along the seismic profile 

    # (assumes a straight line) 

    total_dist_along_line = np.sqrt((dx**2) + (dy**2)) 

 

    # calculate the true x (easting) and y (northing) values for the 

    # interpretation this depends on the relative position of the 

    # first shot point (sw, se, nw, or ne) - as specified in the 

    # function input 

    if first_sp_relative_position == "sw": 

        # where the first shot point is in the south west, both x and y increase 

        true_x = ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dx / total_dist_along_line) 

        ) + first_sp_x 

 

        true_y = ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dy / total_dist_along_line) 

        ) + first_sp_y 

 

    elif first_sp_relative_position == "se": 

        # where the first shot point is in the south east, x decreases whilst y 

        # increases 

        true_x = first_sp_x - ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dx / total_dist_along_line) 

        ) 

 

        true_y = ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dy / total_dist_along_line) 

        ) + first_sp_y 

 

    elif first_sp_relative_position == "nw": 

        # where the first shot point is in the south east, x increases whilst y 

        # decreases 

        true_x = ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dx / total_dist_along_line) 

        ) + first_sp_x 

 



 

72 

        true_y = first_sp_y - ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dy / total_dist_along_line) 

        ) 

 

    elif first_sp_relative_position == "ne": 

        # where the first shot point is in the south east, both x abd y decrease 

        true_x = first_sp_x - ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dx / total_dist_along_line) 

        ) 

 

        true_y = first_sp_y - ( 

            (sample_x_vals - np.min(sample_x_vals)) * (dy / total_dist_along_line) 

        ) 

 

    # calculate the depth of the horizon below seabed 

    depth_mbsf = ( 

        (abs(horizon_resample[:, 1]) - abs(seabed_resample[:, 1])) / time_divider 

    ) * seis_velocity_m_per_s 

 

    # in this case, the interpolation will have generated horizon points shallower 

    # than the seabed, indicating where the horizon has pinched to the seabed 

    # therefore, we want to define these areas as 0 depth below seabed 

    depth_mbsf[depth_mbsf < 0] = 0 

 

    # compile the calulcated data into a dataframe ready for output (note in this 

    # example, the coordinate reference system is British National Grid, so the 

    # x and y fields are labelled appropriately) 

    output = pd.DataFrame({"X_BNG": true_x, "Y_BNG": true_y, "depth_mbsf": depth_mbsf}) 

 

    # export the output to a csv file 

 

    # first generate appropriate name 

    outfile = "%s_horizon_mbsf.csv" % seismic_line 

 

    # send data to file 

    output.to_csv(outfile, float_format="%.4f", sep=",", index=False, header=True) 

 

""" Example use of function """ 

calculate_horizon_depth_mbsf( 

    seismic_line="line_1", 

    seabed_csv="./interps_exported_from_arc/line_1_seabed.csv", 

    horizon_csv="./interps_exported_from_arc/line_1_horizon.csv", 

    first_sp_x=448042.37707, 

    first_sp_y=1122202.8878, 

    last_sp_x=518531.69499, 

    last_sp_y=1124974.14703, 

    fudge_factor=10, 

    s_or_ms="ms", 

    first_sp_relative_position="sw", 

    interp_x_uses="x", 

    seis_velocity_m_per_s=1700, 

)  
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EXAMPLE INPUTS FOR CODE 

The example code above requires two file inputs in the form of csv files, which can be generated from 
picks made by following the first 4 steps in section 6. There should be one file for the seabed, and one 
for a deeper horizon that has been interpreted. The conversion of the POINT_Y field to depth is 
performed within the code. See comments within code above for explanation of user-specified function 
inputs. 
 

   

Figure A1. Format of csv files required for code. (Seabed file is on the left, horizon file is on the right). 

 

The POINT_X fields do not need to match, as long as the coordinate format is the same – as scripted 
above, the code will sort the values for POINT_X and POINT_Y based on ascending order for POINT_X 
and resample at integer values in POINT_X, so that the result matches exactly, and a straightforward 
subtraction performed. 

As per the specifics of the script above, the input csv files are stored in a ‘interps_exported_from_arc’ 
directory and the script should be run from one directory level up: 
 

 

Figure A2. 

At the base of the script above there is an example use of the function, showing the user defined inputs, 
for a southwest to northeast trending seismic profile where the picks have been extracted. Running the 
function will generate a three-column csv file, as shown in Figure A3, stored in the same directory as the 
code. 

 

Figure A3. 

The function can be re-run for each line where there are picks to be processed, and the resulting csv 
files compiled into a XYZ file, which can be imported to ArcGIS Pro, or used to generate a gridded 
surface.  
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